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Tabla 1 

 FAVORABLE DESFAVORABLE 

 FORTALEZAS DEBILIDADES 

ANÁLISIS 

INTERNO 

Por la naturaleza del negocio, ni los 

clientes ni lo proveedores aglutinan 

mucho poder de negociación frente a 

nosotros. 

Actualmente no hay competidores, y 

por lo tanto no hay mucha rivalidad. 

Tampoco parece haber servicios 

claramente sustitutivos a corto plazo. 

El mercado de la formación está en 

crecimiento. 

El sector tiene una debilidad que es la 

de fácil intrusión de competidores a 

corto plazo por falta de barreras de 

entrada. 

Con la excepción de que a medio plazo 

nos podamos apalancar en el efecto 

red y en ser los primeros en penetrar el 

mercado para ser referentes. 

 OPORTUNIDADES AMENAZAS 

ANÁLISIS 

EXTERNO 

España en términos globales facilita 

algunos aspectos del emprendimiento 

en materia de garantías legales de los 

procesos. 

Los hábitos de consumo se dirigen 

claramente hacia el canal online. 

Se valora las iniciativas con impacto 

social como empresas a las que hay 

apoyar. 

La economía española está en una 

situación muy complicada. 

El emprendimiento en España tiene 

retos en cuanto a acceso a 

financiación, y también en cuestión de 

tiempo y coste de procesos y 

procedimientos de constitución y 

puesto en marcha de una empresa. 

 

Imagen 1 
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Tabla 2 

 

Criterio Variable Comprador Vendedor 

Geográfico País ESPAÑA ESPAÑA 

Firmográfico 

N.º empleados 20-200 Máx. 50 

Sector 

Todo el mercado menos 

el sector de fyc y 

reclutadoras 

Reclutadora y FyC en: 

- Hardskills 

- Cultura del cambio 

- Digitalización 

- Comportamiento y 

liderazgo 

- Bienestar y salud 

Puesto  CEO, DG o Dir. RRHH Freelance o Socio/DG 

Psicográfico 

Empresas 

nativas 

digitales o que 

quieran 

digitalizarse 

“No somos capaces de 

encontrar y probar a 

nuevos proveedores a 

través de procesos 

rápidos y baratos” 

“No estamos sabiendo 

estar presentes en el 

mercado online y escalar 

nuestras acciones 

comerciales” 

Actitudinal 

Creen que la 

formación es 

vital para el 

progreso 

“Estamos convenidos 

del impacto de la fyc en 

la empresa” 

“Nuestro producto y 

profesionales son un 

valor que no somos 

capaces de hacer llegar a 

más clientes para 

transformar sus 

empresas” 
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Tabla 3.1 

INPUT ETIQUETA OUTPUT 

▪ España 

▪ Contactos de 2º y 3º grado 

▪ Todas las industrias menos (RRHH, Consultoras y 
Reclutadoras) 

▪ 50-10.000 empleados 

▪ “Director de RRHH” o “HR” (excluyendo consultores y 
coaches) 

Alto directivo 

RRHH mercado 

masivo español 

13.000 

perfiles 

▪ España 

▪ Contactos de 2º y 3º grado 

▪ Todas las industrias menos (RRHH, Consultoras y 
Reclutadoras) 

▪ 50-200 empleados 

▪ “CEO” o “Director General” 

Alta dirección de 

PYMEs 

españolas 

8.500 

perfiles 

Tabla 3.2 

INPUT ETIQUETA OUTPUT 

▪ España 

▪ Contactos de 2º y 3º grado 

▪ Empresas de RRHH, Consultoras y Reclutadoras. 

▪ Autónomos y >10 empleados 

▪ Consultor, coach, fundador  

Profesionales 

independientes y 

pequeña 

consultora 

española 

7.000 

perfiles 

▪ España 

▪ Contactos de 2º y 3º grado 

▪ Empresas de RRHH, Consultoras y Reclutadoras. 

▪ 11-200 empleados 

▪ Ventas, fundador o DG 

Directores de 

venta y DG de 

consultoras 

PYME española 

3.500 

perfiles 
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Gráfico 3 
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Interesar y deseo: durante el 

evento ofrecemos el dto. del 50% si 

se paga anualmente, 360 €. 3 

usuarios se acaban haciendo 

usuarios premium, 1080 €. 

Usaremos WebinarJam. 

 

 

Comprometer: ofrecemos el registro gratuito a TRAINON para que 

prueben a subir su primera propuesta, y con el registro les inscribimos sin 

coste a un webinar para explicar cómo subir y generar visitas a su 

propuesta. Se registran, 60 usuarios. Las tasas de conversión por 

servicios freemium son mucho más altas siempre, más aún cuando hay un 

lead magnet gratuito como es el caso del webinar. 

Nutrir y activación: con los datos facilitados en la LP, 

mandamos recordatorios para el webinar, donde 

finalmente se presentan 30 personas registradas (que 

sabemos son freemium). Aquí usaremos campañas de 

emailing automáticas de Mailchimp. 

 

Interesar y deseo: durante el 

evento ofrecemos el dto. del 25% si 

se paga anualmente, 540 €. 2 

usuarios se acaban haciendo 

usuarios premium, 1620 €  

 

 
Interesar y deseo: durante el 

evento ofrecemos la suscripción 

normal (regalando bono 

posicionamiento) 60€/mes. 4 

usuarios se hacen premium, 240 

€/mes. 

 

 

Fidelizar: es vital aumentar el CLTV 

en este tipo de modelos de 

suscripción, cuanto más tiempo estén 

más rentabilidad. (Branding) 

 

 
 
 
Atracción: se lanza una campaña de vídeo-marketing por LinkedIn ADS para vendedores 

potenciales en TRAINON. Sabemos que el CPC medio es de unos 2 €/clic (Nuñez, 21)i.         

Por lo tanto, si invertimos 75 €/día durante 10 días, obtendríamos aproximadamente 375 clics 

con destino a una LP para el perfil de vendedor potencial en TRAINON. 

CLTV – Inversión = 

1080 -750 = 330 € 

ROI = 330/750 = 44% 

De 375 clics 3 ventas. Un 

0,8% de conversión. 

CLTV – Inversión = 

1080 -750 = 330 € 

ROI = 330/750 = 44% 

De 375 clics 2 ventas. Un 0,5% 

de conversión. Se reduce 

porque es más caro. 

CLTV 4 meses – 

Inversión = 960 -750 

= 210 €                 

ROI4 = 28% 

CLTV 6 meses – 

Inversión = 1440 -

750 = 690 €         

ROI6 = 92% 

 

De 375 clics 4 ventas. Un 1% 

de conversión porque es 

suscripción mensual y menos 

importe. 

ESCENARIO 

INICIAL 

ESCENARIO 

B 

ESCENARIO 

C 

Nos dirigiríamos al 3,5% 

del mercado prospectando 

en LinkedIn. (375/10.500) 

Imagen 2 
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Gráfico 41 

Comprador 

 
 

 
 
 
 
Vendedor 
 
 

 

 

1 Este recurso es propiedad de Ana Ivars con razón social Minsk Online Marketing S.L y extraído del artículo “Cómo 

hacer un Mapa de Empatía paso a paso” en su blog 

No podemos 

permitirnos seguir 

pagando a consultoras 

grandes 
El proveedor de 

siempre no nos ofrece 

otras alternativas 

formativas 

¿Por dónde empiezo a 

buscar a un consultor 

o formador? 

¿Cómo sé si lo que 

pago a mi proveedor 

es caro o barato? 

Mucha oferta de 

formación y consultoría 

últimamente 

La empresas top no 

paran de formar a sus 

equipos 

Los equipos parecen 

ser más productivos y 

estar más motivados si 

se les forma 

Emails y emails de 

consultores, formadores y 

empresas ofreciéndome 

resultados increíbles 

Hay que buscar alternativas, 

pero la formación ahora 

mismo implica poner al 

equipo de RRRHH a trabajar 

muchas horas 

Miedo de desenfocar al equipo en 

una tarea que no acaba de ver que 

tenga un retorno 
Un cambio a bien puede implicar un 

impacto directo en el bienestar de 

los equipos, satisfacción de los 

directivos y retorno a medio plazo 

en los accionistas. 

Ahorro en la partida de gastos del 

plan de formación, aumento de la 

productividad y motivación. 

Proponer un cambio y que no tenga 

buena acogida 

No hay manera de 

llegar de nuevos 

clientes 
No tengo propuestas 

nuevas para retener a 

mis clientes actuales 

¿Cómo digitalizo mi 

proceso de venta? 

No llego a todo, estoy 

solo/a 

Un sector en 

crecimiento, pero 

paralizado por el 

COVID-19 

Se premia al que más tiene. 

La “pescadilla que se 

muerde la cola”  Las 

consultoras grandes se lo 

llevan casi todo 

Que parece que el 

mercado se está 

reactivando poco a poco 

Que si te posicionas en 

internet hay mercado 

Que si te posicionas en 

internet hay mercado 

Da los primeros pasos en 

su digitalización: webinars, 

videos y blog 

Trata de innovar en su 

contenido para 

diferenciarse 

Baja precios para atraer, 

pero no se acaba de surtir 

efecto 

Miedo a perder a sus clientes 

actuales y no generar ingresos 
Que sus acciones 

comerciales se diluyan una 

y otra vez 

Poder hacer llegar propuestas de 

valor a nuevos clientes potenciales 
Estar más presente en el 

mundo online 

https://anaivars.com/mapa-de-empatia/
https://anaivars.com/mapa-de-empatia/
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Tabla 4  
Mes Año 

Plug-ins WP2           25,00 €         300,00 €  

Host + Dominio           20,00 €         240,00 €  

Reg. Marca           15,00 €         180,00 €  

Desarrollo/mto. web e ID corporativa        100,00 €      1.200,00 €  

Inversión en ADS (Google y LinkedIn)3        300,00 €      3.600,00 €  

Gestora        60,00 € 720,00 € 

TOTAL        520,00 €  6.240,00 € 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2 A saber los siguientes plug-ins: Woocomerce y su extensión de suscripciones y DIVI. 
3 Cantidad basada en mi experiencia en el lanzamiento de Avyliti y en consulta con 
profesionales del sector como la agencia Vahid Digital Marketing 

https://www.ionos.es/alojamiento/alojamiento-web
https://quickpatent.es/?gclid=Cj0KCQjwjPaCBhDkARIsAISZN7RKlUTEl1lQcUCGScxBrHABpMxyIxQ1LBdBK6WKgFLF09tEYR-6BmcaAuXSEALw_wcB
https://www.dreamsign.es/quiero-empezar-mi-negocio-en-internet/
https://woocommerce.com/products/woocommerce-subscriptions/
https://www.elegantthemes.com/join/
https://www.vahid.es/
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Imagen 3 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  



Estudios de Economía y Empresa 

 

TRAINON 

133  

 

 

 

Tabla 5 

 BBDD TRAINON 

Inversión 56 €/mes por usuario4. 60 €/mes por usuario. 

Comunicación 

Lenta y fría: en caso de que la 

ficha de la empresa tenga algún 

contacto suelen ser emails o 

cuentas de RRSS (social 

selling). (2 puntos) 

Rápida: subes tu propuesta 

genérica sobre un producto o 

servicio de fyc para que 

usuarios que están buscando 

te encuentren. (7) 

Escalabilidad 

No: es un trabajo muy poco 

escalable que te obliga a hacer 

acciones de comunicación uno 

por uno tras realizar las 

búsquedas. (1) 

Sí: las propuestas se suben 

una vez y se posicionan en el 

buscador para impactar en 

muchos usuarios al mismo 

tiempo. (9) 

Información 

inicial 

Breve: lo que podamos decir en 

un email, o un mensaje directo 

en RRSS si te aceptan. (4) 

Amplia: la propuesta es la 

carta magna de cualquier 

interacción en el sector fyc. No 

es definitiva, pero sí que es 

una primera aproximación con 

mucho valor para el 

comprador. (7) 

Conveniencia 

Muy baja: si es un email y baja 

si es a través de RRSS. El 

cliente potencial no espera que 

una empresa que no conoce le 

contacte ofreciendo algo que 

quizá ni necesite. (2) 

Muy alta: los usuarios activos 

quieren vender o comprar. (9) 

RESULTADO 9 PUNTOS: 22,5% 32 PUNTOS: 80% 

 

 

 

 

4 Punto medio entre el precio de ambos proveedores de la nota anterior. 
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Tabla 6 

 Social Selling TRAINON 

Inversión 67 €/mes5 por usuario. 60 €/mes por usuario. 

Comunicación 

Lenta: te tienen que aceptar 

como contacto, tienen que 

ver tu contenido, tienen que 

estar dispuesto a plantearse 

que seas un proveedor 

interesante, etc. (4) 

Rápida: subes tu propuesta 

genérica sobre un producto o 

servicios de fyc para que 

usuarios que están buscando 

te encuentren (7) 

Escalabilidad 

Sí: existen robots que 

contactan automáticamente 

desde Sales Navigator. Dux-

Soup es uno de ellos pero 

con límite de 500 al día (8) 

Sí: las propuestas se suben 

una vez y se posicionan en el 

buscador para impactar en 

muchos usuarios al mismo 

tiempo (9) 

Información 

inicial 

Breve: lo que podamos decir 

en un mensaje director inicial, 

lo que diga nuestro perfil y 

nuestra web (si es que llega 

tan lejos el usuario) (4) 

Amplia: la propuesta es la 

carta magna de cualquier 

interacción en el sector fyc. No 

es definitiva, pero sí que es 

una primera aproximación con 

mucho valor para el 

comprador (7) 

Conveniencia 

Baja: en las redes social, 

aunque sean profesionales, 

no tiene por qué haber una 

intención de compra (3) 

Muy alta: los usuarios activos 

quieren vender o comprar (9) 

RESULTADO 19 PUNTOS: 47,5% 32 PUNTOS: 80% 

 

 

 

 

 

 

5 En Sales Navigator 

https://www.dux-soup.com/linkedin-automation-that-works?fpr=undomash
https://www.dux-soup.com/linkedin-automation-that-works?fpr=undomash
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Tabla 7 

 Google AdWords TRAINON 

Inversión 100 €/mes6 60 €/mes por usuario. 

Comunicación 

Medía: primero hay que 

ganar la puja y posicionarse 

entre los primeros, luego el 

usuario entra a tu web y si lo 

que ve (que no suele ser muy 

preciso) le gusta, contacta. 

(5) 

Rápida: subes tu propuesta 

genérica sobre un producto o 

servicios de fyc para que 

usuarios que están buscando 

te encuentren. (7) 

Escalabilidad 

Sí: los anuncios se 

mantienen en el tiempo y 

generan tráfico de buena 

calidad a tu web en 

comparación con otros 

canales de publicidad. (9) 

Sí: las propuestas se suben 

una vez y se posicionan en el 

buscador para impactar en 

muchos usuarios al mismo 

tiempo. (9) 

Información 

inicial 

Breve: lo que podamos 

transmitir en la web o la LP a 

la que dirijamos, por eso 

suele haber un CTA que 

invite a seguir conversando. 

(llamada o webinar) (6) 

Amplia: la propuesta es la 

carta magna de cualquier 

interacción en el sector fyc. No 

es definitiva, pero sí que es 

una primera aproximación con 

mucho valor para el 

comprador. (7) 

Conveniencia 

Alta: el usuario está 

buscando y eso es clave, 

pero la búsqueda no siempre 

significa intención de compra. 

(7) 

Muy alta: los usuarios activos 

quieren vender o comprar. (9) 

RESULTADO 27 PUNTOS: 67,5% 32 PUNTOS: 80% 

 

 

6 Es muy complicado establecer un presupuesto fiable, pero menos de 100 € es difícil 
rentabilizar y sacar conclusiones. Por otro lado, no se está imputando el coste de una agencia, 
especialista que gestione el plan de acción SEM. 
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Imagen 4 
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Tabla 8 

 

 Google TRAINON 

Variedad 

Media: aunque hay miles de 

millones de entradas en 

Google, uno acaba entrando 

en las de la primera página. 

(3 puntos) 

Alta: se podrá filtrar por varios 

parámetros para reducir al 

máximo y encontrar 

exactamente lo que se busca 

de una amplia variedad. (8) 

Precio 
Muy pocas veces se sabe el 

precio. (2) 

Precio orientativo por horquilla 

o fijo negociable en fases 

posteriores. (7) 

Información 

sobre 

contenido y 

formato 

Medio-bajo: como hemos 

visto hay mucha información 

que no se presenta en una 

web acerca del servicio. (6) 

Medio-alto: el soporte siempre 

será una propuesta genérica 

que precisamente quiere 

trasladar el máximo de 

información al comprador 

potencial. (8) 

Autoridad 

Depende de cada empresa, 

pero normalmente se 

transmite muy bien el 

prestigio del formador, 

consultor o la empresa, con 

CV o casos de éxito. (9) 

Las propuestas tendrán un 

apartado específico para poder 

transmitir la autoridad y 

prestigio del servicio. (8) 

RESULTADO 20 PUNTOS: 50% 31 PUNTOS: 77,5% 
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Tabla 9 

 Referencia TRAINON 

Variedad 

Nula: una persona te puede 

dar quizá dos o tres 

posibilidades, pero no más. 

Tampoco conoce la oferta del 

mercado. (0 puntos) 

Alta: se podrá filtrar por varios 

parámetros para reducir al 

máximo y encontrar 

exactamente lo que se busca 

de una amplia variedad. (8) 

Precio 

Si fue la persona que 

contrato en su momento, 

sabrá el precio. De lo 

contrario, es complicado que 

tenga esa información. (5) 

Precio orientativo por horquilla 

o fijo negociable en fases 

posteriores. (7) 

Información 

sobre 

contenido y 

formato 

Alto: debería saber qué 

implementó el proveedor, 

cómo lo hizo y el contenido 

en general. Por eso se suele 

usar la referencia como canal 

de prospección. (9) 

Medio-alto: el soporte siempre 

será una propuesta genérica 

que precisamente quiere 

trasladar el máximo de 

información al comprador 

potencial. (8) 

Autoridad 

Suele saben quiénes son en 

términos de reputación el 

proveedor que aconseja (9) 

Las propuestas tendrán un 

apartado específico para poder 

transmitir la autoridad y 

prestigio del servicio. (8) 

RESULTADO 23 PUNTOS: 57,5% 31 PUNTOS: 77,5% 
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Gráfico 5 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

INVERSIÓ
N 

CONVENIENC
IA 

Bases de datos y 

prospectores 
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Gráfico 6 

 

 

 

 

 

 

 

 

VARIEDAD

D 

INFORMACIÓN  

(contenido y precio) 

Referenciado 
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Manual 

 

1. PLUGIN YOAST SEO - Mejora el posicionamiento web 

1.1 Instalar y acceder a la MetaBox 

1. Descarga y activa el plugin ‘Yoast SEO’ (el plugin viene previamente configurado). Por 

lo general, es recomendable mantenerlas en su estado predeterminado.   

2. En la barra lateral izquierda del editor de WordPress Ir a “páginas” > “Todas las 

páginas”.  

3. Seleccionar qué página queremos optimizar y seleccionar la opción de “editar”. 

 

En la parte inferior del editor de cada página encontraremos la MetaBox de Yoast SEO. En esta 

Metabox se podrá añadir y editar contenido esencial para el posicionamiento SEO además de 

ofrecer un análisis del estado actual de la página respecto a SEO y Legibilidad.  

1.2 Optimizar contenido a través de la MetaBox 

1. Elige la “Frase clave objetivo” para la página. MetaBox > SEO > Frase clave objetivo. 

La Frase Clave Objetivo será para la cual se busca optimizar la página. Las recomendaciones 

SEO proporcionadas por el plugin partirán de la palabra clave escogida.  

2. Añadimos un título, un slug y una descripción optimizada para la página. MetaBox > SEO > 

Vista previa de Google  

a) Título SEO: 70 caracteres como máximo e incluir la palabra clave o sinónimos. Ser 

descriptivo.  

 

b) Slug: la extensión después del dominio para esa página. Debe ser breve y descriptiva. 

No usar números ni símbolos. Incluir palabra clave si es posible.  

 

c) Meta descripción: utilizar 150/160 caracteres, incluir la palabra clave o sinónimos. Ser 

descriptivo.  

 

d) Análisis SEO: tras haber realizado los dos pasos anteriores, en MetaBox > SEO > 

Análisis SEO encontrarás recomendaciones respecto al SEO organizados con un código 

de color.  

 

e) Sigue las recomendaciones. Edita los aspectos que salen marcados en rojo y naranja 

hasta que se vuelvan verdes.  

 

f) Asegura que la página está indexada. MetaBox > SEO > Avanzado 
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g) Repasa el análisis de legibilidad y corrige las recomendaciones siguiendo el mismo 

código de colores.   MetaBox > Legibilidad. 

 

 

Las opciones más avanzadas y específicas es recomendable mantenerlas en su estado 

predeterminado si no se tiene experiencia en SEO, ya que el plugin viene preparado para 

impulsar el posicionamiento web desde el momento de su instalación.  

 

2. PLUGIN WOOCOMMERCE - Crear una tienda en WP  

2.1 Descarga y activa el plugin Woocommerce  Plugins > Añadir nuevo > Woocommerce > 

Instalar ahora > Activar.  

2.2 Realiza una configuración inicial básica automática a través del asistente de 

configuración. También se puede acceder a través de Woocommerce > Inicio > finalizar 

configuración > detalles de la tienda.  
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a. Inserta la dirección de la tienda: Inicio > finalizar configuración > detalles de la 

tienda > detalles de la tienda 

 

b. Inserta el sector al que pertenece la tienda: Inicio > finalizar configuración > 

detalles de la tienda > sector 

 

c. Inserta el tipo de producto que vendes (las opciones gratuitas incluyen 

productos físicos y descargas): Inicio > finalizar configuración > detalles de la 

tienda > tipos de productos 

 

d. Inserta los detalles del negocio (cuántos productos se venden y si vendes en 

otro establecimiento): Inicio > finalizar configuración > detalles de la tienda > 

tipos de productos 

 

e. Inserta tema para la tienda: Inicio> finalizar configuración > detalles de la tienda 

> Tema 

 

2.3  Finaliza la configuración de la tienda siguiendo los siguientes pasos Woocommerce > 

Inicio > finalizar configuración.   

2.4  Configura los métodos de pago:  Woocommerce > Inicio > finalizar configuración > 

Configuración pagos (Se ofrecer 4 métodos recomendados: Stripe, Paypal, Contra 

Reembolso y Transferencia bancaria directa) Las pasarelas de pago más utilizadas son 

Paypal y Stripe, se recomienda contar con al menos una de ellas.  Si quieres consultar 

más métodos además de los predeterminados → Woocommerce > ajustes > pagos.  

En las pasarelas de pago (Stripe y Paypal) vincula tu cuenta para poder recibir pagos. (Crea 

una cuenta de Stripe y Paypal previamente para poder recibir los pagos)  

 Cómo crear una cuenta en Paypal y Stripe para recibir pagos 

PAYPAL STRIPE 

1) Vete a la página de inicio en www.paypal.es 
2) Haz clic en Crear cuenta. 
3) Selecciona su país e idioma. 
4) Haz clic en Abrir cuenta. 
5) Completa la información, y haz clic en 

Aceptar y crear cuenta. 
6) Una vez creada correctamente la cuenta, la 

cuenta quedará activada y lista para ser 
conectada con woocormerce.  

1) entra en https://dashboard.stripe.com/register 
2) rellena los datos del formulario ‘ Crea tu cuenta 

de stipe’ (Email, nombre, país y contraseña) 
3) Confirma la dirección de correo (te enviarán un 

email de confirmación) y accede a tu cuenta 
4) Añade un nombre a la cuenta pintando en 

‘Añadir un nombre’ en la esquina superior 
izquierda 

5) Termina de configurar pinchando en ‘Activa tu 
cuenta’ en el menú lateral izquierdo, e inserta 
todos los datos.  

6) Una vez completados todos los campos, pulsar 
en ‘Enviar solicitud’, y la cuenta quedará 
activada y lista para ser conectada con 
woocormerce.  

 

 

https://dashboard.stripe.com/register


Estudios de Economía y Empresa 

 

TRAINON 

243  

 

 

a. Configura los impuestos:  Inicio > finalizar configuración > Configuración impuestos  

Sigue los pasos y configura los impuestos de las ventas y conecta con tu tienda para 

automatizar el proceso y hacerlo más sencillo y rápido.  

- También se pueden configurar manualmente  

- Si no se cobra impuestos pulsar la opción ‘No cobro impuestos’ 

 

3. CATEGORÍAS Y SUBCATEGORÍAS: Productos y Proyectos 

Es muy recomendable categorizar los productos en categorías y subcategorías para agilizar la 

búsqueda a los clientes.  

Estas categorías pueden ser generadas en el archivo CSV mencionado anteriormente y luego 

importarlo, para que una vez se suban todos los productos, ya se suban categorizados.  

1. Crea tus categorías y subcategorías. Accede a Productos > Categorías. 

 

2. Define qué categorías y subcategorías quieres crear. Ejemplo: Categoría → Madrid, 

Subcategorías: Alcobendas, Alcorcón, Móstoles, Algete...etc.  

 

3. Añade primero las categorías generales e independiente (serán las categorías padre)  

Productos > Categorías. 

 

4. Añade las subcategorías (cada categoría padre puede contar con numerosas 

subcategorías). Para añadir subcategorías, sigue el mismo proceso, con la excepción 

de que esta vez, en la opción ‘Categoría padre’, se debe seleccionar la categoría 

correspondiente a la que se quiera relacionar la subcategoría.  

 

5. Una vez añadidas y ordenadas todas las categorías y subcategorías, en la parte 

derecha de la pantalla se visualizará un resumen de todas las características de las 

categorías y subcategorías.   

 

4.  FILTROS DE PRODUCTOS 

Para filtrar la búsqueda de productos en la tienda de woocommerce se hará uso de un plugin 

que al instalarlo, se generarán nueva opciones de widgets, que son los que controlan el filtrado 

de productos por atributos.  (El filtrado es por ATRIBUTOS no por CATEGORÍAS, por lo que 

hay que asegurarse que aparte de ordenar los productos en categorías, estén bien definidos 

los atributos. Ejemplo: tipo: ‘Servicio/producto o proyecto’.) 

1. Instala el plugin gratuito.  Plugins > Añadir Nuevo > Advanced AJAX Product Filters > 

Instalar > Activar. 
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2. Una vez instalado, viene configurado previamente de manera automática. Se 

recomienda no variar la configuración. Para acceder a la configuración en caso de 

desearlo, aparecerá en el menú lateral izquierdo una nueva opción dentro de 

‘Woocommerce’. WooCommerce > Product Filters > General. 

 

3. Una vez configurado, para añadir los filtros hay que acceder en el menú lateral 

izquierdo a Apariencia > Widgets. Dentro de los widgets aparecerá un filtro nuevo 

llamado ‘AJAX Product Filters’. Pincha en la nueva opción y arrástrala hasta el espacio 

donde quieres que se visualicen los filtros, por ejemplo, la barra lateral. 

 

4. Ahora una vez ha sido añadido el widget a la barra lateral, toca crear los filtros 

partiendo de los atributos. Pueden crearse tantos filtros como atributos se tenga.  

 

 

- Title: añade el título que se muestre en el filtro. por 

ejemplo, ‘Precio’, ‘Localización’... 

- Attribute: atributo que se va a filtrar. Ejemplo: 

localización.  

- Type: se decide cómo va a visualizarse las opciones 

del filtro, en lista, en un slider, etc. 

- Text before/after: sirve para añadir un pequeño texto, 

por ejemplo ‘Desde’ ‘Hasta’, cuando se habla de 

filtrado de precio. No es necesario rellenarlo.  

 

 

 

 

5. FACTURAS PARA WOOCOMMERCE:  PLUGIN WooCommerce PDF 

Invoices & Packing Slips  

1. Instala y activa el plugin. Plugins > Añadir Nuevo > Woocommerce PDF Invoices & 

Packing Slips > Instalar > Activar 

 

2. Una vez instalado, aparecerá un nuevo apartado en el menú de Woocommerce. 

Woocommerce > Facturas PDF 

  

Accede a la pestaña ‘Facturas PDF’ y configura las opciones ‘General’ y ‘Documentos.  
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3. Woocommerce > Facturas PDF > General. En este apartado, podrás configurar todo lo 

referente a la factura, que aparecerá y qué no, tamaño de la factura, etc. son los 

ajustes generales de la propia factura, entre los que encontramos: 

- Cómo visualizar la factura 

- Tamaño del papel (A4 recomendado) 

- Añadir imagen en la cabecera (logotipo de la empresa) 

- Altura del logotipo (en cm) 

- Nombre y dirección de la tienda 

- Pie de página (términos y políticas de privacidad) 

 

4. Woocommerce > Facturas PDF > Documentos. En este apartado se realizan ajustes 

respecto a cuándo enviar una factura. el apartado más importante es el ‘Adjuntar a’, 

donde se decidirá cuándo y dónde adjuntar la factura creada en el punto anterior.  

 

5. ¡Listo! una vez creada y configurada la factura se enviará automáticamente a las 

opciones seleccionadas en el apartado ‘Adjuntar a’. Para poder obtener una vista 

previa de las facturas de cada pedido, accede a Woocommerce > Pedidos, y en la 

derecha del listado de pedidos aparecerá un icono por cada pedido, donde se podrá 

visualizar la factura de cada uno de esos pedidos.  

 

6. PLUGIN - Admin. de Usuarios, Roles y Capacidades  

Lo primero de todo, antes de pasar a editar los roles y capacidades que se dan a cada usuario 

en WP, es importante crear los usuarios en el apartado del menú lateral izquierdo de 

WordPress. Usuarios > Añadir nuevo. 

User Roles and Capabilities: se pueden gestionar las capacidades de cada rol, además de 

asignar permisos para la gestión y administración de los plugins. (De esta manera podemos 

controlar el acceso a cada uno de los plugins y evitar problemas).  

User Roler Editor: Permite gestionar las capacidades de cada rol excepto del perfil 

administrador. Este plugin intenta facilitar la gestión permitiendo hacer asignaciones 

simultáneas. La versión de pago es muy completa, pero la gratuita no permite gestionar el 

acceso a los plugins. Es el más popular.   

7. GOOGLE ANALYTICS - Analiza las estadísticas de tu web 

7.1 ¿Cómo crearse una cuenta Google Analytics? 

a. Registrarse en Google Analytics. 

b. En la parte inferior izquierda veremos una ruedecita que pone administrador. Hacemos 

clic. 

c. Introducimos el nombre de nuestra cuenta. 

d. Nos pedirá qué queremos medir: web, aplicaciones o web y aplicación. El caso más 

común es medir los datos de una web. Elegir esta opción. 

e. Si hemos seleccionado web, es hora de configurar la propiedad. Debemos facilitar los 

siguientes datos: 

https://analytics.google.com/analytics/web/provision/#/provision
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f. Nombre del sitio web 

g. Url del sitio web 

h. Categoría de sector al que pertenece nuestro negocio 

i. Zona horaria de informes 

j. Llegados a este punto tenemos que aceptar las condiciones de servicio de Google 

Analytics del país o región correspondiente, en nuestro caso sería España. Para 

continuar, debe de aceptar todas las condiciones de protección de datos. 

k. Y por fin Google Analytics nos devolverá nuestro código de seguimiento. Debemos 

copiarlo y pegarlo: es el código de seguimiento en el primer elemento <HEAD> de 

todas las páginas web de las que quiera realizar el seguimiento. 

7.2 Instalación de Google Analytics en WP de manera manual  

b) Copiar el ID de seguimiento de nuestra cuenta en Analytics.  

 

c) Como la instalación va a ser manual, habría que entrar en el gestor de archivos de 

nuestro sitio web. Se puede acceder a través del propio editor de temas de WordPress: 

Apariencia > Editor de temas (en la barra lateral del Escritorio).  

 

d) Una vez dentro, buscar el archivo header.php: donde pone “Plantillas” > cabecera del 

tema (header.php). Este archivo es parte del core de WP.  

 

e) Dentro del  fichero header.php, buscar la etiqueta “<head></head>” y colocar el código 

ID que hemos copiado previamente desde Google Analytics. Es posible que ya haya un 

código introducido, así que podemos pegarlo antes o después siempre y cuando esté 

dentro de la etiqueta <head>. Es muy importante respetar el código que hay dentro. 

Una vez introducido el código ya podremos guardar y salir. Por último, comprobar que el código 

funciona correctamente a través de Google Analytics. 

 

7.3 Instalación de Google Analytics en WP con un plugin   

 
Existen muchos plugins en Google Analytics, pero el que vamos a utilizar es:  ”Google Analytics 

by Monsterinsights”. Porque este plugin es muy bien valorado y disponer de muchas funciones:  

Ir a Plugins > Añadir nuevo > Buscar “Google Analytics” y nos devolverá como resultado 

algunos plugin relacionados con Analytics > Google Analytics by Monsterinsights > Activar el 

plugin.   

a. Conectar la web con Google Analytics > clicar en “Clic here to authenticate manually” > 

introducir el código UA-XXXXXXX en la casilla que aparece.  

b. Comprobar que la web recoge datos de Analytics: Abre tu cuenta de Analytics y elige 

informes en tiempo real. No cierres Analytics, navega por tu web, verás que apareces 

en los informes como un usuario activo. 

7.4 ¿Cómo funciona Google Analytics?  

 

https://es.wordpress.org/plugins/google-analytics-for-wordpress/
https://es.wordpress.org/plugins/google-analytics-for-wordpress/
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Google Analytics utiliza las “Cookies”, que son fragmentos de código JavaScript que permiten a 

las webs rastrear y obtener datos de la actividad que realizan los usuarios cuando  visitan 

nuestra web o aplicación.  

 

Los datos que recogemos de los usuarios a través de las cookies, son enviados a la cuenta 

que hemos creado en Google Analytics. 

 

Por su parte, Google Analytics nos agrupa toda esta información y nos la muestra a través de 

los informes, una vez hemos insertado el código de seguimiento en todas las páginas de la 

web. Así recoge los datos Google Analytics: 

 

- El usuario visita nuestra web. 

- El código de seguimiento inserta una cookie en su navegador. 

- El ID de seguimiento, recibe datos a través de la cookie enviándolos a Google Analytics. 

- Google Analytics nos muestra datos agrupados en informes: audiencia, adquisición, 

comportamiento y conversiones. 

 

7.5 ¿Cómo usar Google Analytics para conocer el comportamiento de los 

usuarios en una web?  

 
Toda la información que va recopilando Google Analytics nos la muestra a través de los 

informes de Audiencia, Adquisición, Comportamiento y Conversiones.  

 

1. Dimensiones en Google Analytics  

 

Las dimensiones son atributos cualitativos de datos que podemos desglosar. Por ejemplo, 

podemos analizar los datos de nuestra web desglosándolo por la dimensión país. Tipos de 

dimensiones secundarias en Google Analytics:  

 

- Dimensión Categoría de dispositivo:  Por el tipo de dispositivo que nos han visitado. 

- Dimensión Fuente/medio: Si el tráfico que nos llega es directo, orgánico o de pago 

- Dimensión Campaña: Si estuvieras realizando campañas en Google Ads nos mostraría la 

campaña que estamos realizando. 

 

 

2. Métricas en Google Analytics  

 

Las métricas podríamos definirlas como variables cuantitativas, que muestran como valor un 

dato numérico o porcentual.  

 

- Sesión: es el periodo en el que un usuario interactúa con nuestro sitio web o aplicación 

durante un intervalo de tiempo. Un mismo usuario puede realizar varias sesiones. El final de la 

sesión finaliza cuando el usuario cierra el navegador o pasan 30 minutos de inactividad en la 

página. Es por eso tener en cuenta la métrica de usuarios únicos. 

 

- Visitantes únicos: Para saber si los visitantes son únicos, lo hace a través de las cookies que 

instalamos en el navegador cuando el usuario accede a nuestro sitio en un periodo específico. 

Es decir, si un usuario entra en nuestra web a las 10:30 de la mañana, genera una visita. Si 

vuelve a entrar con el mismo navegador a las 16, supondría otra visita. Al tratarse de la misma 

https://www.fullweb.es/agencia-google-ads
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cookie, Google Analytics no lo tiene en cuenta  y lo  cuenta como un "visitante único". 

 

- Páginas vistas: número total de páginas vistas que se cargan en un navegador. Cuenta el 

total de visitas que realiza un usuario en nuestra web. Si un usuario visita la página A, después 

navega a la página B y vuelve a la página A, Google Analytics lo  contabilizará como un usuario 

y 3 páginas vistas. 

 

- % de rebote: Porcentaje de sesiones de página única. Puede ayudar a medir la calidad del 

tráfico, pero cuidado, acompañado de  otras métricas como el, promedio de tiempo en la 

página. El porcentaje de rebote es una métrica sobrevalorada y hay que tratarla con cuidado. 

Es muy habitual por ejemplo encontrar % de rebote altos en páginas únicas tipo landing page o 

cuando el usuario encuentra la información que buscaba y desde la misma página abandona la 

sesión. Tener un % de rebote alto no significa que tu página no sea de interés.  

 

- Duración media de la sesión:  La media de tiempo que está el usuario visitando nuestro site. 

 

3. Informes en Google Analytics  

 

Informes de audiencia:  

Los informes de audiencia nos ofrecen datos sobre los usuarios que visitan nuestra web o app. 

Estos informes que ofrece Google Analytics son muy útiles para saber las características de los 

usuarios que nos visitan, imprescindible para conocer mejor qué tipo de público nos visita. 

Otros datos que podemos consultar son:  

 

- Datos demográficos comprende básicamente datos sobre la edad y sexo de nuestros 

visitantes. 

- Intereses: Categorías de afinidad, segmentos en el mercado y otras categorías que dichos 

usuarios manifiestan con sus actividades de compra y viajes online. 

- Información geográfica:  idioma y ubicación de los visitantes. 

- Comportamiento: en este tipo de informes podemos hacer comparaciones entre las visitas 

que nos realizan usuarios nuevos frente a recurrentes, la frecuencia,  asiduidad y la interacción. 

- Tecnología: qué tipo de navegador, sistema operativo y red utilizan los usuarios cuando nos 

visitan. 

- Móvil: tipo de dispositivo que utiliza el usuario cuando visita nuestra web como desktop, 

mobile y  tablet. 

 

Informes de adquisición:  

Si queremos saber cómo llegan los usuarios a nuestro sitio web, los  informes de adquisición 

son la solución ideal. Gracias a ellos, podremos saber entre otras cosas si los usuarios llegan 

directamente o a través del motor de búsqueda, desde qué ruta ha accedido a nuestro sitio 

web. Además, si estamos utilizando campañas de marketing como Google Ads, los informes de 

adquisición permiten conocer la eficacia de las mismas, si nos están funcionando o si estamos 

perdiendo dinero e incluso qué campañas podríamos mejorar. 

 

Todo este tráfico es agrupado en varios canales de captación (la forma en cómo acceden los 

usuarios a nuestro site): 

 

- Organic Search (motor de búsqueda) 

- Direct (usuarios que escriben directamente el dominio) 

- Referral (dominios de referencia) 
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- Paid Search (campañas de marketing) 

- Social (redes sociales) 

- Affiliates (afiliados) 

- Display (campañas de marketing) 

 

Informes de comportamiento:  

Este tipo de informes ofrecidos por Google Analytics nos ayudan a entender cómo interactúan 

los usuarios en nuestra web. Hay algunas métricas que nos ayudarán a sacar conclusiones y 

valorar la calidad de la sesión, como el número de páginas vistas por sesión, duración media 

de la sesión, porcentaje de rebote, usuarios nuevos y otras métricas interesantes. 

 

Qué informes de comportamiento podemos consultar: 

 

- Velocidad del sitio: Muestra la velocidad de carga de la página. Con esta información 

podemos mejorar nuestra estrategia de contenidos y de esta manera retener y fidelizar al 

usuario (es importante ofrecer contenido relevante). 

- Búsqueda en el sitio: se utiliza sobre todo en sitio web tipo ecommerce y medios digitales ya 

que evalúa las búsquedas que se realizan a través del buscador interno de la web. Para que 

muestre correctamente este tipo de información tenemos que configurar en la vista de nuestra 

cuenta y habilitar “Seguimiento de la búsqueda del sitio” 

 

- Eventos: Para recibir información sobre los eventos, lo tenemos que crear previamente. 

Podríamos resumir como eventos una acción que quieres medir en tu web. Por ejemplo, crear 

una llamada a la acción CTA y saber cuántos clics ha recibido por parte de los usuarios que 

visitan nuestra web. 

 

Informes de conversiones:  Los informes de conversiones se centran básicamente en  micro y 

macro conversiones. 

 

- Micro conversiones: las que utilizas en un embudo de conversiones como, por ejemplo, un clic 

en un botón, ver un vídeo o descargar un e-book. 

 

- Macro conversiones: se dan cuando un usuario realiza una compra completa,  una 

transacción. 

 

Las micro conversiones ayudan a que el usuario realice una macro conversión. Por ejemplo, en 

una landing page tenemos un banner con una llamada a la acción de un producto (micro), el 

usuario hace clic en el botón, le lleva al producto donde decide finalmente comprarlo (Macro). 

 

https://www.fullweb.es/marketing-contenidos
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Gráfico 8
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Tabla 10 
 IT SOPORTE MARKETING VENTAS 

 IT SOPORTE MARKETING VENTAS 

Contacto con el 

usuario 

Informar de nuevos 

cambios y 

funcionalidades 

técnicas en 

TRAINON 

Resolver cualquier 

duda o incidencia que 

impida al usuario hacer 

uso de TRAINON 

(técnico o financiero) 

Comunicar los 

beneficios, ventajas e 

iniciativas de 

TRAINON a través de 

campañas masivas 

(on y offline) 

Comunicar 

información comercial 

y resolver dudas 

sobre el servicio a 

clientes específicos. 

Equipo de 

trabajo 

Desarrollar y mantener la plataforma para 

que su uso sea intuitivo y efectivo. UX y UI. 

Construir productos, acciones comerciales y 

mensajes dirigidos a generar más usuarios 

satisfechos (nuevos y actuales). 

Comité 

estratégico 

Tomar decisiones dirigidas a que TRAINON se acerque cada vez más a ser un ”espacio 
diseñado para que se encuentren empresas que quieren compartir conocimiento, 
habilidades y experiencia, con fin el último de transformar a las organizaciones y las 
personas.” 
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Tabla 11 

 

 RRH INNOVACIÓN FINANZAS 

Como departamento Desarrollar planes de 

formación y desarrollo, 

asuntos de tipo 

legal/laboral, incentivos y 

relaciones laborales. 

Investigar a acerca de 

nuevas vías de desarrollo 

del negocio vía comité, por 

petición de los usuarios o 

por iniciativa propia. 

Gestionar de un modo 

rentable y transparente las 

necesidades y recursos 

financieros de la empresa. 

Como equipo de trabajo Crear proyectos y ejecutar acciones concretas dirigidas a satisfacer las necesidades 

que se planteen en los comités o proponer iniciativas propias que tengan como objetivo 

mejorar la experiencia integral del usuario y el empleado con la plataforma. 

Comité estratégico Tomar decisiones dirigidas a que TRAINON se acerque cada vez más a ser un 
”espacio diseñado para que se encuentren empresas que quieren compartir 
conocimiento, habilidades y experiencia, con fin el último de transformar a las 
organizaciones y las personas.” 

 

Tabla 12 
 PESIMISTA ESPERADO OPTMISTA 

Financiación total 3 años (€) 30.000 77.532,8 77.532,8 

Ventas en 3 años (nº. 

usuarios) 
500 1.400 2.000 

Primer mes de facturación 9º 5º 5º 

R.E 3er año (€) 

 
56.815,04  

Con pérdidas 
el 1er año 

 

346.695,22  
Sin pérdidas cada 

año 

598.320,22  
Sin pérdidas 

cada año 
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2021 Vida útil
Amort. 

2021
2022 Vida útil

Amort. 

2022
2023 Vida útil

Amort. 

2023

€ Años € € Años € € Años €

INVERSIÓN 50.589,40 1.114,00 33.444,40 4.364,00 26.499,00 3.630,00

Inmobilitzado Intangible 2.140,00 1.114,00 11.140,00 2.114,00 13.000,00 2.300,00

Desarrollo 0,00 0,00 0,00

Concesiones Administrativas 0,00 0,00 0,00

Propiedad Industrial 1.140,00 10,00 114,00 1.140,00 10,00 114,00 3.000,00 10,00 300,00

Fondo de Comercio 

Derechos de Traspaso 0,00 0,00 0,00

Aplicaciones Informáticas 1.000,00 1,00 1.000,00 10.000,00 5,00 2.000,00 10.000,00 5,00 2.000,00

Inmobilitzado material 0,00 0,00 16.500,00 2.250,00 8.900,00 1.330,00

Terrenos y Bienes Naturales

Construcciones 0,00 0,00 0,00

Instalaciones técnicas 0,00 0,00 0,00

Maquinaria 0,00 0,00 0,00

Utillage 0,00 0,00 0,00

Otras Instalaciones 0,00 0,00 0,00

Mobiliario 0,00 10.000,00 10,00 1.000,00 4.000,00 10,00 400,00

Equipos para el Proceso de Información 0,00 6.000,00 5,00 1.200,00 4.400,00 5,00 880,00

Elementos de Transporte 0,00 0,00 0,00

Otro Inmovilizado Material 0,00 500,00 10,00 50,00 500,00 10,00 50,00

Inversiones inmobiliarias 0,00 0,00 0,00 0,00 0,00 0,00

Inversiones en terrenos

Inversiones en construcciones 0,00 0,00 0,00

Tesorería 48.000,00

Efectivo

Bancos 48.000,00

IVA Inversión 449,40 5.804,40 4.599,00

Cuota generada 449,40 5.804,40 4.599,00

Tabla 16 

 

 

Tabla 17 

 AÑO 1 AÑO 2 AÑO 3 

 Nº 
€/año 

persona 
Nº €/año persona Nº €/año persona 

Socios 3 12.000 3 30.000 3 30.000 

Prof. Independiente 
1 

(IT) 
12.000 Gestor 5.000 Gestor 5.000 

Plantilla 0 0 2 30.000 7 30.000 

Total 4 48.000 6 155.000 11 305.000 
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Tabla 18 

 

 Inversión (€/mes) Nº clics Premium (nº usuarios) 

Promoción 50% 

(anual) 
2.250 1.125 12 

Promoción 25% 

(anual) 
2.250 1.125 8 

Full price (mes) 2.250 1.125 

16 

(al pagar mensualmente es más fácil captar 

usuarios nuevos) 

 

Imagen 5 

 

 

 

 

 

 

 

 

 



Estudios de Economía y Empresa 

 

TRAINON 

403  

 

 

Tabla 19 

 

 

 

 

 

 

 

Tabla 20  

 

Tabla 21 

Tabla 22 

 

Mes 1 2 3 4 5 6 7 8 9 10 11 12 

Costes 4.539,41  4.584,29  4.979,13  4.973,92  6.468,67  8.463,37  10.458,04  16.452,65  16.447,23  16.441,75  16.436,23  16.430,67 

N.º 
suscrip. 
50% 

13 13 14 14 

Cumul  26 40 54 

N.º 
suscrip. 
25% 

    12 16 19 30 30 30 30 30 

Cumul      28 47 77 108 138 169 199 

Beneficio 0 0 0 0 0 0 0 0 0 0 0 0 

 AÑO 1 AÑO 2 AÑO 3 

Capital (€) 50.589,40  33.444,40  26.499,00  

Plazo (Años) 5 5 5 

Rentabilidad (%) 10 10 10 

ROI (€) 13.078,65 5.068,94 3.160,19 

ACTIVO 2021    2022    2023  

ACTIVO NO CORRIENTE 1.026,00  1,40%   23.188,00  6,21%   35.980,00  4,39% 

ACTIVO CORRIENTE 72.284,89  98,60%   350.237,59  93,79%   783.196,49  95,61% 

TOTAL ACTIVO 73.310,89  100,00% 
 

373.425,59  100,00% 
 

819.176,49  100,00%           

PATRIMONIO NETO Y PASIVO 2021    2022    2023  

PATRIMONIO NETO 15.993,47  21,82%   213.805,62  57,26%   515.500,84  62,93% 

PASIVO NO CORRIENTE 31.336,30  42,74%   34.057,26  9,12%   27.565,49  3,37% 

PASIVO CORRIENTE 25.981,12  35,44%   125.562,71  
    

TOTAL PATRIMONIO NETO Y PASIVO 73.310,89  100,00% 
 

373.425,59  100,00% 
 

819.176,49  100,00% 

 Inicio 1 2 3 4 5 6 7 8 9 10 11 12 

Cobros 48.000,00  0,00  0,00  0,00  0,00  4.356,00  8.712,00  13.068,00  17.424,00  32.670,00  32.670,00  32.670,00  32.670,00  

Pagos 0,00  4.071,63  5.342,13  5.826,13  5.826,13  7.641,13  10.061,13  12.481,13  19.741,13  19.741,13  19.741,13  19.741,13  19.741,13  

Flujo  -4.071,63  -5.342,13  -5.826,13  -5.826,13  -3.285,13  -1.349,13  586,87  -2.317,13  12.928,87  12.928,87  12.928,87  12.928,87  

Cumul 48.000,00  43.928,37  38.586,23  32.760,10  26.933,96  23.648,83  22.299,70  22.886,56  20.569,43  33.498,29  46.427,16  59.356,02  72.284,89  
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Tabla 23 

 

Mes 1 2 3 4 5 6 7 8 9 10 11 12 

Costes 4.272,75  4.471,71  4.670,67  4.669,62  4.668,57  4.667,50  4.666,42  4.665,34  6.164,24  8.163,14  10.162,03  16.160,91  

N.º suscrip. 
50% 

12 12 13 13 

Cumul  24 37 50 

N.º suscrip. 
25% 

    9 9 9 9 11 15 19 30 

Cumul      17 26 35 46 61 80 110 

Beneficio 0 0 0 0 0 0 0 0 0 0 0 0 

Imagen 6 
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